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1. INTRODUCTION 
This document describes the processes for translating software for the WCIS application. 

1.1 Glossary of Terms 
TERM DEFINITION 

MSDEV Microsoft Visual Studio 2005 
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1.2 Section Overview 

The intent of this section is to identify that Siemens Building Technologies, Inc., located in 
Buffalo Grove, Illinois, will support the screen translation efforts of WCIS Version 3.0 (or later) 
performed by the Group Countries into their own local native language. 

This section also identifies the procedures for translation and support that will be required by the 
Group Countries and those to be provided by Buffalo Grove. In the event that an error is 
identified, during either the translation or through the normal course of running the software, 
please follow the procedures and guidelines listed below. These procedures have been specified 
to focus on the cause and nature of the error and facilitate a quick and timely resolution to the 
problem. 

1.3 Language Translation Support 
Each Group Country is responsible for translating of the product into their language at their 
location.  

1.3.1 Pocket PC Language Support 

WCIS can be translated for the Pocket PC version. However, it will support only those languages 
that are listed in the Regional Settings dialog box in the Pocket PC device. Eastern Asian 
languages (such as Japanese) may require additional font support or another software application 
installed on the Pocket PC device. 

1.3.2 Task Breakdown by Location 

Siemens Building Technologies, Inc., Building Automation Unit (Buffalo Grove, IL) will 
provide the following in support of the language translations: 

 WCIS software that has support for language translations. 

 Documentation on the procedures required for the translation. 

Each local Group Country will provide the following in support of the language translations: 

 The Microsoft Visual Studio 2005, HTML HelpWorkshop, Homesite 5, and Adobe 
Acrobat 6.0 tools for the language translations. These may be purchased in the local 
country language. 

 Personnel to do the translation and testing of the translation. 

 A way of distributing the translated files to your branches. 

 Send a copy of the completed translation files (software and help files) to Buffalo Grove 
for archiving and future test purposes. 
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2. GETTING STARTED 
This section describes the steps you will need to perform to prepare for the translations. The 
scope of this document only serves to describe the steps required to translate the WCIS screen 
information from English into other languages. This document is not meant to describe how to 
use the WCIS software, how to configure the system, how to setup point information, nor how to 
use the Microsoft Visual Studio 2005 tool. 

This document assumes that the user of these procedures is familiar with both the WCIS and the 
Visual Studio software applications, understands the standard Microsoft Windows file names 
and conventions, and understands the Microsoft Windows system entities. 

2.1 Software Required 
The following software programs are used to translate the WCIS application: 

 You will need to install a copy of Microsoft Visual Studio 2005 (English or Local 
Language) on the computer with which you will be doing the translations. There are 
other 3rd party tools that can be used to do language translation, but this document only 
lists the steps for this tool. When installing this software, select the typical installation. 

 WCIS needs to be installed on the same computer. 

 The Microsoft Windows XP (Service Pack 2) or Windows Vista Installation Disks. 
This may be required to select and install the Local Language definitions. To install the 
language support, go to the Control Panel and select Regional Settings. In the Regional 
Settings Properties tab, select the new language that is to be translated. You may be 
prompted for the Microsoft Windows XP (Service Pack 2) or Windows Vista  disk at this 
time. Refer to section 2.2 

 

Software Type of User Documentation 

Local Language Windows XP (with SP 2) 
or Windows Vista, Windows Mobile 5.0 or 
6.0 Pocket PC Operating Systems. 

HTML Help, WebHelp, Manuals 

Internet Explorer 6.0 HTML Help, WebHelp 

WCIS  HTML Help, Manuals 

Microsoft Word 2003 or later, local language 
edition  

HTML Help, Manuals 

HomeSite 5.5 or later HTML Help 

Microsoft HTML Help Workshop 1.3 HTML Help 

Adobe Reader 6.0 or later Manuals 

Other 3rd party tools for translating text HTML Help, WebHelp, Manuals 

 Copyright 2010 Siemens Industry, Inc. 



Translation Instructions for WCIS Software 
Revision: 2.0 August, 2010 page: 6 of 26 

 

 Copyright 2010 Siemens Industry, Inc. 



Translation Instructions for WCIS Software 
Revision: 2.0 August, 2010 page: 7 of 26 

2.2 Setting Up Language for New Translations 
This procedure is to install additional language at your machine. 

1. From Start>Settings, click Control Panel. Double click on Regional and Language 
Options icon. 

 

 

2. From the Languages tab, in the Supplemental language support section, you must select 
both the check boxes. 

3. From the Advanced tab, in the Code page conversion tables section, select the appropriate 
language check boxes. 
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4. Click OK. 

2.2.1 General Translation Procedure 

The following procedure describes the overall process for translation. More complete 
information is provided in Section 3 of this document. 

1. Open WCIS_Res.dll as "Resource" in Visual Studio. 

2. Edit each of the resources for dialogs, accelerators, menus, etc. and change the resource 
strings to the target language (Japanese, for example). 

3. Along with WCIS_Res.dll, you must modify resources from CT_Common.dll and 
Device.dll to complete the translation. 

4. Save the files with unicode encoding. 

Note: Make sure to copy the appropriate WCIS_Res files in the installation directory. 
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3. TRANSLATION STEPS 
This section describes the steps needed to translate the WCIS application. 

3.1 Before You Begin 
Before you begin the translation process, make copies of the DLL files that are stored in the 
installation folder (typically, C:\Program Files\Siemens Building Technologies\WCIS). Use 
the copies as your working files. When you have finished the translation, replace the DLL files 
in the installation folder with the translated DLL files. 

3.2 Starting the Translation 
1. Start up Microsoft Visual Studio 2005. This should have been loaded in Section 2.1 

Software Required on page 7. 

2. From the File menu, click Open, and then click File. 

3. In the Look in field, navigate to the folder where you stored the copied *.dll files. Select 
an application DLL (such as WCIS_Res.dll) and then click on Open. 

 

Figure 1 - Open dialog box 

4. Once the application DLL is open, the following list should appear: 
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Figure 2a –Application Components. 

5. Right click on the name of the .dll (WCIS_Res.dll, for example), and click Properties. 

 

Figure 3b – Properties 

6. In the Properties frame, set the MFC Mode to True. 

7. Click Save. Close the properties frame. 
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NOTE: If an error message displays after selecting a language or attempting to save the 
changes, then the installed operating system does not support that language and additional 
language support will need to be installed. You may not be able to save any of the changes 
until all the language support has been installed. For example:  English NT does not support 
Japanese, so Japanese NT is required for the translation and must be installed before the 
translation can begin. See the Microsoft Windows documentation for the steps on installing 
the additional language support. 

 Copyright 2010 Siemens Industry, Inc. 



Translation Instructions for WCIS Software 
Revision: 2.0 August, 2010 page: 12 of 26 

3.3 Translating Dialog Boxes 
1. In Visual Studio, double-click the Dialog folder to display the list of dialog boxes. 

Double-click on the first item. A window appears containing the selected dialog box. 

 

Figure 4 - Dialog box Properties 

2. In the dialog box, click on the control text. A rectangle (indicated by the small squares) 
will highlight the control that is selected. Double click on each control that contains text. 
A Properties dialog box appears for the control you selected. Translate the text that 
appears next to the Caption field. Notice that the text is translated on the actual dialog as 
you edit the Caption field. When you finish translating the Caption text for all control 
fields in the dialog box, click Save, and then close the Properties dialog. 

NOTE: You must save the file after you change each resource. If you do not save the 
file before changing the language on the next element, changes to previous elements 
may be lost. 

3. If the translated text no longer fits in the control, the control can be resized and 
rearranged in the dialog box as follows: 

 To move a control, click on it and, while holding the left mouse button down, drag 
the control to a different location. Release the mouse button to drop the control. (This 
is known as the “drag and drop” method.) 

 To resize a control, select it and touch the mouse to the border of the rectangle. The 
mouse cursor will change into arrows. Hold down the left mouse button to stretch the 
control to the size you wish. Release the mouse button to stop resizing. 

NOTE: Please do not re-order the dialog box entries. Attempt to maintain the same 
order of the controls from one language to another. This aids other operators who 
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know the software and the locations of options but might not know the language 
that is displayed. 

4. Some of the controls (push buttons, radio buttons, checkboxes, etc.) will have an ‘&’ sign 
in front of one of the letters. This symbol causes the following letter to be underlined and 
that letter becomes the hot key for that control. The ‘&’ symbol may be put in front of 
any letter; just make sure that each letter is only used once per dialog box. It is ok to 
remove the ‘&’ if you do not want any hot keys. 

5. Go through the dialog box, translating all controls that contain text. Not all controls 
contain text; just skip the ones that don’t. 

6. Repeat this procedure for all dialog boxes in the Dialog folder. 

3.4 Translating Menus 
1. Open the Menu folder for the DLL you are translating, and double-click on an item. 

 

Figure 5 - Menu Selections 

2. Double click on a command (in this example, the Export menu item is selected). 
Translate the text next to the Caption field. The following example shows the “Export” 
caption translated to Japanese: 
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Figure 6a – Menu Properties Dialog box 

NOTE: The \t combination inserts a horizontal tab in the caption. For example, the \t 
in the Exit caption inserts a tab between the word Exit and the accelerator Alt+F4 key. 

3. Click Save. Close the properties dialog, and repeat process for the rest of the menu items. 

4. Repeat Steps 2 and 3 for all menus in the menu folder for the DLL you are translating. 

NOTE: Some menu items have an accelerator associated with it. You can change the 
letter after the Ctrl+ and it does not have to be the same letter that is underlined. If this 
is changed, keep a hard-copy list of menu command IDs (the number in the ID field in 
the above dialog) and Ctrl lettersYou will need this when translating the Accelerators. 
If the system will be used with dual or multiple languages, it is recommended that the 
accelerator keys not be changed. 

3.5 Translating Accelerators 
If any of the letters used with the CTRL key in the menus were changed, the accelerator table 
will need to be updated to match the list of Menu Command IDs and Control Letters you created 
while translating the menu items. Make a hand-written list of the changes. You will need this list 
later. 

If no accelerator keys were changed, skip this section. 

1. Open the Accelerator folder, and double-click on the first item. A list is displayed with 
pairs of menu IDs and accelerator keys. 
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Figure 7 - Accelerator List 

2. Using the handwritten list you made while translating the menus, update each entry by 
double-clicking on it to display the Accelerator Editor Properties dialog. Only the letter 
next to the Key field needs to be changed. 

 

Figure 8 - Translating Accelerators 

NOTE: Do not change the number in the ID field. 
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3. Click Save. Repeat this procedure for all accelerators that need to be translated. 

4. If there is more than one item listed in the Accelerator folder, then repeat this procedure 
for all items (usually there is only one item). 

3.6 Translating String Tables 
This is where most of the work lies. Attempt to translate strings to approximately the same 
length or less as the English string. They can be longer, but do not be intentionally verbose. This 
rule is especially important in the string table of WCIS_Res.dll. 

1. Open the String Table folder, and double-click on the String Table item. A large grid 
will open containing all the strings used by the application. 

 

Figure 9 - String Table 
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2. Right click on an item in the Caption column of the WCIS_Res.dll(String Table) tab, 
and select Properties to display the String Editor. 

 

Figure 10- String Properties Dialog Box 

3. In the String Editor, translate the text next to the Caption field for each string in the 
table. 

Be sure not to alter the following items when translating strings: 

Character Function/Translation Procedure 

\n These characters are used in menu strings to separate status bar text 
from tool tips. The text before the \n appears in the status bar at the 
bottom of the window. The text after the \n appears in the tool tip 
when a user points to a toolbar button. Leave the \n in place and 
translate the words around it. 

\r\n These characters are needed for printing. Do not remove them. 

@1%, %s, 
%u, %c, 
etc. 

These character combinations are used for substitutions. Leave 
them in the string, and translate the words around them. 

|| These are separators in open/save dialog boxes. Make sure these 
characters remain in translated strings. 
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3.7 Saving the File 
After you’ve finished translating all the resources, from the File menu, click Save. Answer Yes 
if asked to overwrite the current file. 

3.8 Repeat Steps 
After translating the WCIS_Res.dll, you need to repeat the entire procedure for the remaing two 
files (CT_Common.dll and Device.dll). 

3.8.1 Pocket PC Translation 

If you have installed WCIS on your Pocket PC, and you want the translated files, then you will 
need to copy and translate another set of DLL files. Then, download the translated files to the 
Pocket PC. To do this, perform the following steps: 

1. Copy the WCIS_Res.dll, the CTCommon.dll, and the Device.dll files to another folder. 
These will be your working files. 

2. Complete the translation process as described in Sections 3.2 through 3.8. 

3. When the translation is complete, replace the files in the PPC subfolder of the WCIS 
installation folder of you computer (typically, C:\Program Files\Siemens Building 
Technologies\WCIS\Data\PPC). 

4. Connect the Pocket PC to your computer. 

5. In ActiveSync Explorer, open the Mobile Device folder. 

6. Browse to My Pocket PC\Program Files\Siemens Building Technologies\WCIS. 

7. Overwite the existing DLL files with the translated files. 

3.8.2 Balancer Tool Translation 

3.8.2.1 Desktop Version 

If you have already translated the files for the Desktop version of WCIS, then no further action is 
required. When you generate the Balancer Tool from the translated WCIS, the Balancer Tool 
will display in the new language. 

3.8.2.2 Pocket PC Version 

If you want to use a translated version of the Balancer Tool on your Pocket PC, then you must 
first generate the Balancer Tool from the Desktop version of WCIS, and then download the PPC 
subfolder into the Pocket PC.  

To do this, complete the following steps: 
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1. In WCIS (Desktop version), from the File menu, click Balancer Tool. 

2. After generating the tool, navigate to the folder where the files were copied.  

3. Copy the PPC subfolder, and download it to your Pocket PC. 

NOTE: Using the Balancer Tool from the Pocket PC is a manual process. You must 
navigate to the PPC folder, and double-click on the LCIS.exe file. 

3.9 Testing 
1. Run WCIS. 

2. Check the modified strings and menus.  
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4. HTML HELP 
The HTML Help section covers the following procedures, which you should perform in the order 
presented: 

1. Installing the required software for HTML Help 

2. Creating the Help directory structure 

3. Copying the HTML Help files to your hard drive 

4. Translating HTML Help elements 

5. Compiling HTML Help 

6. Testing HTML Help 

7. Troubleshooting HTML Help 

4.1 Installing the Required Software for HTML Help 
Install the required software for HTML Help, as listed in the 2.1 Software Required section. 

4.1.1 Setting up HomeSite 

To make Internet Explorer the default integrated browser in HomeSite, and to enable other 
useful features, perform the following steps: 

1. From the Desktop, click Start, Programs, HomeSite 5, HomeSite 5. 

2. In HomeSite, click Options, and then click Settings. 

3. In the Settings dialog box, click the Browse icon in the left pane. 

4. In the Browse pane, select Use Microsoft Internet Explorer, and then click OK. 

5. On the Edit tab, enable the following features: 

Word Wrap 
 

Show Gutter 
 

Show Line Numbers in 
Gutter  

4.2 Creating the Help Directory Structure 
To create the directory structure for the Help source files, perform the following steps: 

1. Launch Windows Explorer. 
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2. Navigate to and select the letter that represents your hard drive—for example, C:. 

3. From the File menu, click New, and then click Folder. 

4. Type Help, and then press ENTER. 

4.3 Copying the HTML Help Files to Your Hard Drive 
To copy the HTML Help files to your hard drive, perform the following step: 

1. Navigate to X:\CommissioningTools\WCIS3p0\Translation\Help (where X:\ 
represents the StdApps network drive). 

2. Copy all the Help files to the Help folder you created—for example, C:\Help. 

4.4 Translating HTML Help Elements 
CAUTION: Do not change the names of the Help files. Doing so will prevent them from 
working. 

CAUTION: Do not use RoboHTML to open HTML Help files. Doing so will change the 
appearance of the files and might prevent them from working. 

Here’s a list of Help elements that you need to translate: 

 Titles, headings, and body text 

 Title bar text 

 Books and pages 

 Keywords 

 Graphic text 

4.4.1 Titles, Headings, and Body Text 

To translate titles, headings, and body text for new and existing topics, perform the following 
steps: 

1. From the Desktop, click Start, Programs, HomeSite 5.0, HomeSite 5.0. 

2. In HomeSite, click the Files tab. 

3. Browse to the Help folder where you copied the help files in Section 4.3 (for example, 
C:\Help). 

4. Open a topic file that appears in the directory—for example, 
Calibration_Setup_Wizard.htm. You can identify topic files in the directory by their 

HTM extension and the Internet Explorer icon, , that appears before the file name. 
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5. Translate the title text (line 4), but do not translate the HTML tags. For example, in the 
Calibration_Setup_Wizard.htm topic, you would translate the title, The Calibration 
Setup Wizard, but not the surrounding tags, <title> and </title>. 

6. Translate all headings and body text between the Insight comment tags. In the following 
example—which includes a popup link—the bold text indicates the material you should 
translate:: 

<!-- Begin Insight Help Content --> 

<h1> 

The Calibration Setup Wizard </h1> 

<p class="bodytext"> 

The Calibration Setup Wizard allows you to select a method of calibration. You can 
choose from one to three different options, or you can select a combination of 
options. <a href="javascript:BSSCPopup('Erase_def.htm');" onMouseOver="if 
(parseInt(navigator.appVersion) >= 4) BSPSPopupOnMouseOver(event);;">erase</a> 
choose from one to three different options.</p> 

<!-- End Insight Help Content --> 

SPECIALl NOTES:  

– About links: Do not copy the links, since all linking information you need already 
exists in the HTM topic file. 

– About headings: Also, to save time, you may want to translate the headings directly in 
the HTM topic file. 

– About special characters: some characters in HTML—such as dashes and quotation 
marks—rely upon special codes to display properly. For example, to properly render the 
dashes in the previous sentence, you would represent a dash as follows (see bolded text): 

Some characters in HTML&#151;such as dashes and quotation  
marks&#151;rely upon the special codes to display properly. 
 

You can view a comprehensive list of these special characters by clicking HomeSite’s 
Extended and Special Characters icon on the toolbar. 

7. Click File, and then click Save. 

8. Repeat Steps 4 through 7 for each topic file within the Help project. 

4.4.2 Title Bar Text 

To translate the title bar text for each Help project, perform the following steps: 

1. From the Desktop, click Start, Programs, HTML Help Workshop, HTML Help 
Workshop. 

2. In HTML Help Workshop, click File, and then click Open. 
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3. Browse to the project file you want to translate—for example, C:\Help\ WCIS.hhp—
and then click Open. 

4. In the Project tab, click the Add/Modify Window Definitions icon. The Window Types 
dialog box displays. 

5. In the General tab, translate the text in the Title Bar Text field, and then click OK. 

4.4.3 Table of Contents 

To translate the Table of Contents for each HTML Help project, perform the following steps: 

1. Click the Contents tab. 

2. Click an entry. 

3. Click Edit Selection. 

4. In the Entry Title field, translate the text. 

5. Click OK. 

6. Repeat Steps 2 through 5 for each book and page entry. 

4.4.4 Keywords 

To translate the keywords for each Help project, perform the following steps: 

1. Click the Index tab. 

2. Click an entry. 

3. Click Edit Selection. 

4. In the Keyword field, translate the text. 

5. Click OK, and leave HTML Help Workshop open. 

4.4.5 Graphics  

Many topics contain screen captures. You may want to re-do the screen captures after you have 
translated the WCIS user interface. 

4.5 Compiling HTML Help 
You need to compile each HTML Help project after you translate the required Help elements. 

To compile an HTML Help project, perform the following steps: 

1. In HTML Help Workshop, click File, and then click Compile. The Create a Compile 
File dialog box displays. 
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2. If the name of the project you want to compile does not display in the Project File field, 
browse to it. 

3. Check Save All Files Before Compiling, and then click Compile. The Microsoft HTML 
Help Compiler compiles the project and displays the results in the right pane. 

4. Click View, and then click Compiled File. The View Compiled File dialog box displays. 

5. If the name of the compiled file you want to view does not display in the Compiled File 
field, browse to it, and then click View. 

6. Review the compiled file to make sure that you have translated all the required Help 
elements. 

7. Do one of the following: 

 If the file is accurate, click File, Save Project, and then click File, Close Project. 

 If you overlooked one or more of the Help elements, repeat the appropriate steps, and 
then re-compile, view, save, and close the project. 

4.6 Testing HTML Help 
To test your Help files from within an application, perform the following steps: 

1. Copy the .CHM file to the folder where WCIS is installed. 

2. Launch WCIS. 

3. From the Help menu, click Help Topics, or click the Help button if no menu exists. If 
the application Help does not open, follow the instructions in the 4.4.8 Troubleshooting 
HTML Help section. 

4. From the WCIS Help, open the help topics, and then test all the links. If you have any 
problems opening the Help files, follow the instructions in the Troubleshooting HTML 
Help section. 

4.7 Troubleshooting HTML Help 
To troubleshoot your help files, perform the following steps: 

1. Run the English version of the CHM file to verify that it is functioning properly and that 
the problem is not within the original Help files. 

2. Make sure that the CHM files are all located in the correct directory. 

3. Make sure that the CHM file names match the file names on the Translation CD. 

4. If you have broken links, review the HTML code associated with the link, and make sure 
that you have not translated any JavaScript or HTML tags. Also make sure that you have 
not translated or changed any of the file names the links point to. 
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5. SAVING AND COPYING TO MULTIPLE SITES 
Once the DLLs have been tested and verified for the new language, then copy all three DLLs in 
the installed WCIS directory. Copy them onto a media type (for example, writeable CD-ROM or 
a flash drive) that can be used to transfer the files to other PCs. These files can then be copied to 
multiple PCs.  
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6. TROUBLESHOOTING 
This section describes common problems and possible solutions to the translation of the 
software. 

6.1 Troubleshooting 
Symptom Possible Solution 

Application doesn’t run. 

-or- 

An application crashes. 

A translated string may be too long. There are 
a few places where string lengths are limited. 
Copy the English DLL over the one you 
translated, and see if it runs properly. Then 
translate one part at a time, and test each to see 
if the application runs. 

Strings are cut-off in some dialog boxes. Open the dialog box in Microsoft Visual 
Studio 2005. Find the dialog box with the 
problem. Click on the control that was cutoff. 
Resize the rectangle border so the text will fit. 

There is still English in some places. Open the DLL for the application. Make sure 
you set the language appropriately when you 
completed Section 3. Starting the Translation 
on page 10. Open the dialog box, menu, or 
string table; make sure there isn’t anything you 
forgot to translate. 

The language shows up as invalid 
characters.(Most likely to happen for Japanese) 

The font you chose does not support the 
character set. Go back to Section 3.2 
Translating Dialog Boxes on page 12 and 
select a different font. Make sure you selected 
the correct language in Section 3.1 Starting the 
Translation on page 12. Might be a problem in 
the software that needs to be corrected. 

Reports do not line up, formatting looks bad. Strings in WCIS_Res.dll may be too long. Try 
to re-word them. 
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